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The EEGLAB Matlab software

{
‘-:‘ Computafional
x::, Neuroscience
=

main graphic interface

EEGLARE Shell - Konsole

Session Edit View Bookmarks Settings Help
| EENE B!
/home/arno> matlab -nodesktop File Edit Tools Flot Study Datasets  Helg
<MATLAE >
Copyright 1984-2002 The MathWorks, Inc. No current dataset
Version 6.5.0.180913a Release 13
Jun 18 2002 - Create a new or load an existing datasat;
Lze "File > Import data” (hew
Using Toolbox Path Cache. Type "help toolbox_path_cache" for ﬁ:r ‘File > Load existing dataset” (old)
= If new,
To get started, type one of these: helpwin, helpdesk, or demo. ‘File > Import epoch info” (data epochs) else
For product information, visit www.mathworks.com. “File > Import event info® (continuous data)
"Edit = Dataset info" (addfedit dataset info)
>> eeglabl "File > Sawve dataset” (save dataset)
- Prune data: "Edit > select data”
- Peject data: "Tools = Beject continuous
- Epoch data: "Teeols » Extract epochs”
- Remove baseline: "Tools > Remowve
- RBun ICA: "Tools > Run [CA"
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Importing a dataset

[mpor epoch) info =
[mpor exent info I
Export -

BB Ecit Toolz Plot Stucly Datasets  Help |

_ From ASClffloat file or Matlab array

Fraom continuows or seq. EGI . EAW file
From Multiple seg. EGI RAN files

Load existing dataset
Sawe CUrrent datasetis)
Save current dataset as
Zlear dataset(s)

From BCIZ2000 2A5CI file

Fraom Snapmaster 5hA file

From Meuroscan .CHT file
From Meuroscan EEG file

Create stuchy -

From ERPS: EAM ar EDF file

MNeuroscience

Load existing stuchy
Sawe CURrent study
SAne CUFFenT study as
Zlear sty

From Biosemi .BDF file using BIOS1G
From other formats using BIOSIG

From AMT EEProbe (CHT file
From AMT EEFrobe AVE file

EEGLAB supports many

different raw data formats

Memory options

Sane histars P

Fram Brain %is. Rec. whdr file
From Brain %is. Anal. Matlab file

it

From CTF folder (MEC)

Fram IM5tep  ASC file

From mMayo MEF files

From 40 . m4d pdf file

Trouhleshooting, other data formats. ..
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Imported EEG data

| " M

(| gy LY f A A | f\ 1 A
e oo N A e *-.IH'NI"”'-! MM gl Ll A AU Ml L Lo W A e AL N e hsl i waft by P
'l"l_,qw""w"ﬂ I"u'-"'.r I U,l.ﬁrw "y N [ VI J"w‘l e "-._r.-'“1‘|‘ ﬂ.,qﬁI\WI‘,‘\“_I,.’I,JHI‘.J-L.WM \ W/ *.,'W"..ur_l L ':'-J.""'w'“]l"l ;J.‘ Y ." W r"LFI'rL A F"I'"u oy i m)', .

w
I";

W

CEGLAR v7.1.6.18

File Edit Tools Plot Study Datasets Help

EEGLAB GUI
displays dataset

basics
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The example data: Sternberg working memory

3 -
L —

el File
../Data/stern.set
Data
Continuous data (not epoched), ref‘d to right mastoid
Task
3-7 letters to memorize, among 1-5 letters to ignore
50% chance of probe letter being ‘in-set’
Fixation Maintenance
(5 ﬁec) (1.4 sec) (2-4@59‘3) Prjbe
+| M| |L||T||G||P||Y]||Q]||W]|]|-
Memorize

lgnore

Was this letter in the memorized set?

EEGLAB Workshop X, June 14-17, 2010, Jyvaskyla, Finland: Julie Onton — Data import

RESPONSE




Comments in EEGLAB structure

-

i B ™y

About this dataset

Data acguired by: Julie Onton -~
Data acqguired on: Qct 15, 1274

Task ('eventnames') :

— Ewvery trial preceded by 5 sec fixation ('fix') -

3,5,7 letters to memorize (in black, =x, 'B']

- 5,3,1 letters to ignore (in green, =%, 'gB')

- B-letters total per trial

- Z-4 gec variable maintenance period ('WH')

FProbe letter
pPress response
- Subkdject was to indicate by left or right mouse
button (with right hand) whether the probe
letter was in-set (left,'in') or out-of-s=t
{right,'out')

— If the response was correct,
one tone ('correct'),
tone ('wrong')

{in red, ex, 'rB')prompted a button

subfect heard one
if incorrect, a different

Peference electrode placed on right mastoid

{Subject indicated sleepiness toward the end of
session) -

SAVE

CAMNCEL |

>> EEG.comments

Cnmpumbnal
MNeuroscience

File

N Tools Plet Stud,

Datasets Help

Datasetinfo
Event fields
Eventwvalues
About this dataset

Channel locations

MS0stern.set
T
B10133

Select data
Select data using ewvents

Select epochs or events

1
1303
250

Copy current dataset
Append datasets
Delete dataset(s)

0.000
2440 528

unknowen
YES

[CA weights
Dataset size (Mh)

S
J514

ntinuous Data——
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Memory options

| - fu |
TR na v s il A M | f il'Jl A \
T T Wi ,._f”"dlr.”l.' A A N M W ol LT AT A o A T T
'l"l_,!w"”w"ﬂ I"u""'.' " S "y N W VL .-'LWI e "-._r..l“"|‘ ‘l"l.fq'I“WIL‘\'\-FMP"""HIM v k'l'WI""'l']'-' (WL l"'u'-..a"wlnjl'fl ) ) .’, W r"LFI'rL *'mf'll"’u W n m)', J

WA
Iy wl

Edlit Tools Plot  Study  Datasets  Help

Import data

Itnpart epoch info
Import event info
Export ¥

Load existing dataset

Set when loading a STUDY

Sawe current dataset(s)

Sawe current dataset as
Clear datasetis)

Create stuchy b

Load existing study
Sawe current stuchy

Sawe current stuchs as

EEE

Clear study

Sawe history
it

=]

<<=

Cancel Ok |
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Re-reference data (if necessary/desired)

| "'m M EREN L i
| 1y A LI | A e ! i
A L / T AL ey | v A
.Fr'. A g ..," 1y |_r, ' LT W M S |, Al I-'"'l. (LR LY, { T | \
LN ! LR

| o [ AL LW o A )
. \ J A T J [ ™

W ey T ", W I"‘,|'f’.1"'||" 1 WA by Waa /L A L M | L ] POrLL Ty oy

! W N I L W [ S b, \ \ W LT LAY AT N BT Al (AT )
WAy T ’ Vo U A L e B A B B U S TV AL T L f

¥
W

File Edit JEZ]E

Plot Study Datasets

Help

Change sampling rate
Filter the data

Re-reference

Interpalate electrodes

Reject continuous data by eye

Extract epochs

Remowe baseline
Run ICA

Remawve compon

Lutomatic chann
Automatic epoch
Reject data epoch
Reject data using

Locate dipoles us

Peak detection us
FMRIE Tools

Locate dipoles us.

EEG = pop reref( EEG, 39);
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Save new dataset, keep old one

Save it as file:

P N
Dataset info -- pop_newset() l = | (=] |ﬁl
What do you want to do with the new dataset?
Mame it: Sternberg Continuous -- Reref'd Edlit description

i s

What do you want to do with 45 old dataset (not modified since last =aved)?

o

Owveryerite S memary (set=ves, unset=create a newy dataset)

Cancel | Help Ok
L%
B Enter fil -5 |
idhleci (B eccLaB v7.17.180
Savein: | [Ji MATLAB =l o File Edit Tools Plot Datasets Help
b= Name = Date modified Type
| N [} H -
Rec;;»;aces external 11/10/2009 5:54 AM  File folder #2: Sternberg Continuous -- Rere...
functions 11/10/2009 5:50 AM  File folder
! plugins 11/10/2009 5:52 AM  File folder Filenarme: none
Desktop sample_data 11/10/2009 5:52 AM  File folder Channels. per frame 70
-~ sample_locs 1171072009 5:52 &AM File folder Frames per EpDCh E10133
=1
Libraries EpDChS 1
) Events 1303
._! Sampling rate (Hz) 250
Computer Epoch start (sec) 0.00a
Q!‘*! Epoch end (sec) 2440528
Netork Reference C7
Channel locations Yes
‘ L g ICA weights Yes
File name: [ | Save | Dataset size (Mh) 349
Save as type: | ("set) ﬂ Cancel

.,

Neuroscience

e S |

[ALLEEG EEG CURRENTSET] = pop newset(ALLEEG,EEG, 1,
"Sternberg Continuous -- Reref""d");

"setname”, ..




Multiple active datasets (ALLEEG)
-

e Neuroscience

r EEGLAB v7.1.6.18b ESREEEC=) r EEGLAB v7.16.18b (o= e S

a

Dataset 1:5Sternberg Continuous Data
v Dataset 2:5ternberg Continuous -- Reref'd

File Edit Tools Plot Datasets Help o File Edit Tools Plot

——#1: 3ternberg Continuous Data—— ——#2: '3ternberg C

Select multiple datasets

Filename: . ustraliaéSTULY S04 stern . set Filename: none

Channels per frame 71 Channels per frame 0
Frames per epoch B10133 Frames per epoch B10133
Epochs 1 Epochs 1
Events 1303 Events 1303
Sampling rate (Hz) 280 Sampling rate (Hz) 250
Epoch start (sec) 0.000 Epoch start (sec) 0.00a
Epoch end (sec) 2441 220 Epoch end (sec) 24470 578
Reference Lnknowin Feference L
Channel locations Yes Channel locations Yes
[CA weights ES |CA weights NS
Dataszet size (Mhb) E98 Dataset size (Mhb) BY3.1

EEGLAB Workshop X, June 14-17, 2010, Jyvaskyla, Finland: Julie Onton — Data import




Scroll channel data

&
e

- Ci"_': i
i T Meuroscience
r ATTRARL l Scroll channel activities -- eegplot()
) ) Figure Display Settings Help k]
File Edit T::u::uls Datasets Help
49 &t Channel locations
T el =
Channel data (scroll) (6] =
o -
: Channel spectra and maps Y e b LR N
Filename: . A e A = I L e e e o e S A el
Channel properties
Channels A
Frames pe T
e e Sy, St Ao e
Epochs ' e e S e
Cverts : = =
Sarmpling | S
Epoch sta Component activations (scroll) MWW
Epochent ===
amponent spectra and maps : e ———
Reference . : , T e
ormponent maps e T S S ey
Channel Ic . . e T T
ICA weight  Compenent properte: = = ==
. i T |
Dataset s - -
* = =
e e e e e e e e e i o]
mﬁm"i v e S S e S v v S el Scale
N — - e e e 37,19
Data statistics » e e s W b/ o S S e A
. 86 87 98 89 90
Time-frequency transfarms »
Chan.  Time Walue
Cluster dataset 1G5 LR E"e”““’es‘ =< | =l s |[=2|/=| (eve sroess -4sama | 319

>> pop eegplot(EEG,1,1,1);
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Scroll channel data

Neuroscience

’
' Scroll channel activities -- eegplot() —

Figure Display | Settings) Help "

Event markers

o = =
channels, tesesrarma P e
e o ey i e ey Pt e A imar v
tlme, ] __ I T T S e
] _. - _- i e ]
events e e Scroll

gtk Py S g eppityig S sy
e T o W buttons

R
}}ﬂgﬁ

e scaling

i o i il Ay Sl il e VR e PNl
iyl ,.-"N"’
MWMW
a7 84
Chan. Titne Walue

REJECT

CANCE'—| E"Em“’pes| s<| sl 85 =1 * | reve srrann nzesw | 3719

EEGLAB Workshop X, June 14-17, 2010, Jyvaskyla, Finland: Julie Onton — Data import



Data importing and channel analysis

Task 2
Import channel location file

Exercise...
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Import channel locations

I f M ' . 1
LAY ML eV i " " A | Whel, .
L y wip L L .__ i % L A
. L'-n" v ) T N - . I’| -'JI‘ Iﬂl’ Plf'-"J I!‘I"‘-I' [ .
W 3 Center for
Cvlllpuullulml
N(‘HIOS(IE‘I’KL‘

x

File i Plot Study Datasets

Dataset info
Event fields

2

Opt. head center
Eventvalues Rotate axis

About this dataset 054374

Channel locations 0.79487

Select data 079917
Select data using events -0.15385 Sph. -= palar & xyz

Transfarm axes

]

Xyz -= polar & sph.

'
N
L
n
it

4
n
o
Y
)

Select epochs or events Polar -= sph. & xyz

4
o
=]
)
LR

Copy current dataset
Append datasets
Delete dataset(s)

Set head radius
Set channel types

Set reference

H II

Delete chan

Plot 2-D | MNosealong+¥ | Plot3-D(xyz)
Read locations ‘ Read locs help Loak up locs Save (other types)
‘ o |

7 file formats supported
(Polhemus, BESA, ...)
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it channel info --

Delete chan

Insert chan

Plat 2-D

Figure 3

File Edit View Insert Tools Desktop Window Help

NS b RAODEL-|G|0E|aD

LEYE Opt. head center T
-45.1543 Rotate axis T
054374 Transform axes Y Cé:'f,‘,:'};,m” al
0.79437 e
07997 ¥yz -= polar & sph.
-0.15585 Sph. -= polar & xy=z
451543 Polar -= sph. & xy=z
-7.8725 -
1.1379 Set head radius
EEG Set channel types :IE:EBGB
Set reference
Cancel Hel Qi
¥
2 = 1 = == Append chan
Mose along +X - Plot 3-D (xyz) —____---_—---
locs help Look up locs Save (as .ced Figure 4 =
E File Edit View Insert Tools Desktop Window Help
Help NEde | AN OPEL 2|08 ad

Channel locations
+X

|
+Y

, PFPEP2
,FQHE‘ 3oAFZARAT AN
[ TEIFwERFaEs2

CFCHFCHFCEGECECE
+TT +CE#C34C14CZC2CA4CH T8
FEPECPTRLRERERGD

$PIPPPEP2P e FP10
’F"f, 3POZP s

+

71 of 71 electrode locations shown

Click on electrodes to toggle name/number

-17, 2010, Jyvaskyla, Finland: Ju

0.8+

0.6

0.4

024

0.4 -




Imported channel locations

| b 0
dn 1 i M i My M 1 A \
f ;Fﬁ“‘ r‘b,'*"'%\l‘.'-” 1y Ir.' J|'|~I‘,Jij‘-'“~'._w\x ey ulJt‘puﬂ_lw'J '.I__,""f‘ﬂ‘,l r"“ | .-'11. J'.;M‘ ", PRV F A | | . ] ]Il’ \n'w"‘rl ”J‘PI«'LI
¥ il ]
) |

el N | b ¢ ot s A Ve AL | " T
'] \ e oy . A L) ey L . \J w M/ |
1|_Jq| Wy Ik.‘qﬁ I"u'- A P/ ¥ \_I.r'ﬁ"i ]| '||"1| \ wI‘\,.\‘a‘_.rjl‘lulq v "HIM' v N I""J']"I WiV s ll"Lll..Jh"‘fn .’, I’Lﬂft A r'll' ALY .

W

File Edit Toaols Plot Study Datasets Help
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Data importing and channel analysis

Task 3
Import data events

Exercise...
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Import data events

I ",,_. \, A A
| " JIL Ly A L | A [
IJ? f .Fr'. A .;‘r,- "L | |.,1- AT LI oy ) Wl A ,;_L [T Y,
.. \ v \r wh

| | ! 1

1L 1 ah ¥ L/ |

[ .l‘ ' I' \-'ll'fﬁ " L - r*., ﬁ‘"l : ' L‘-‘H
\

|
i || [ i’ It I o

L LTI N I PRR T L' PR Sl T P AN |
Ll Mo Wi, ol R T Wl l'LL"..‘"\'.-h"I. N Iflr

|

. |
1M A TN .
HAF Sl AV Ly |

Y i Al I ¥ W
1";-_- [ |_|, W ok L

Wl

Swarts

W Center for
Com putational

euroscience

Edit Tools Plot Study Datasets Help w

[« Import events from Matlab array or ASCII file
l° Import events from data channel

 Import from Presentation event file

| eImport from Neuroscan file

Import data L

Import epoch info

Import event info From Matlab array or ASCI file

Export

From data channel

From Presentation .LOG file
From Meuroscan .ev? file

Load existing dataset

Save current dataset(s)
Save current dataset as
Clear dataset(s)
Create study
Load existing study

Save current study
Save current study as
Clear study

Mermory and other options

History scripts L
Quit
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Appearance of an event channel

Scroll activity — eegplot()

Figure Display Seftings Help

al

’\ ﬂ Scale
1 —_+

4 5 ] 7 i 9
Chan. Time Yalue

=1
CLDSE' Ewent types <= | ill 4 =] == 1 91818 31457 I ad e
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Imported data events

| M " Mmoo A
A TR LY 1 Ay e | f . My |
o N M W “‘«\,,._”l-'tdlr. N Al Ay bl WA TAW AT T Vb L) 1 L T A, [P A | . e | 'L‘l,.-l P TR T T NP
F..I.J“ltt.;nllﬂ;1 I"u"“.' rh,a”" Lyl ¥ v W v v \ -‘Il.m_ i, ‘-._r,'J‘ l.1'|| l'] iy, iy .wkw.- W k_l."\ '.h.',‘\_l I'\\lr‘r".,ul\ ""L‘-,,"\\I-IV'JI'I, l_J'\ '|*|i - ?w:"',‘.‘t',ll' Madt M “".I I,J.« sl
W N Center for

- ] - — — x |
EGLAB 17.17.18 R

File Edit Tools Plot Study Datasets Help N If event |mport was

successful,
you will see an
appropriate

number here
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Review event values

Cnmpm.ﬁm-l

Neuroscience

B EEGLAB v7.1.7.18b

Event 'type' and 'latency'

Dataset info

Ewvent fields

About this dataset

Channel locations
Select data

Select data using events
Select epochs or events
Copy current dataset
Append datasets

Delete dataset(s)

[CA weights
Datazet size (Mh)

File mTtmls Plot Datasets Help

ntinuous -- Rere...—

70
10133
1

1303
280
0.000
2440 52
vl

hil=l
es
345

To resort: first
select Main
sorting field

Insert event =
BEFORE
current event

-

are recognized fields

Delete
Append event || CURRENT
AFTER event

current event

Edit event values — pop_editeventvals() _

Edit event field values {currently 732 events) Delete avant |
Latency (sec) | | 4,964
Type |8 object
Event Num
Insert event | << | < | 2 [ > || »> | Append event |

Re-order events {for review only)

Main sorting field: _IClick for decreasing order

_IClick for decreasing arder

secondary sorting fiald:

Re-sort |

Cancel | Help | Ok |
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b
H.-l I" N |_r.' i I'II

Review event values

Plot Study  Datasets

Dataset info

Event fields

About this dataset
Channel locations
Select data

Select data using events
Select epochs or events
Copy current dataset
Append datasets

Delete dataset(s)

Help u
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Swarts
Center for
Cvmpuullwml
MNeuroscience

Delete event

Trial

Event_Type
Type
Latency (sec)

Picture

Time
Number of -
Uncertainty

Duration
Uncertainty2

RegTime

event fields

IS unlimited

50000

Init_time 0.0227

Duration (sec)
Load

n i
= fa
LTS B % ] -
o -
L (2%

Insert evert

I

I

E E

ﬂ Append event

Mo field selected
Mo field selected




Renaming events

B EEGLAB v7.1.7.18b

o enter for-
2l Computational
[ —— i

File mnmls Plot Datasets Help

Dataset info
Event fields
Event values

About this dataset

. Fil
Channel locations B10133
Select data 1

Select data using events 1303

Select epochs or events 240

Copy current dataset 0.000
A 2440 528
ppend datasets o
Delete dataset(s)
Tes

ntinuous -- Rere...——

b |

1) input original 'type' code
2) Input new 'type' code
3) Keep/delete all other events

Select events — pop_selectevent()

Selection Field Descriptions Selection {value, list or real range "min==max"} If set, select
Field To adit: Bdit = BEvent fialds Ex "Target" or 2:4,5 or 4.5 <= 13 all BUT these
Event indices | ]
latency (s) Mo description [ _
type Mo description [ bpl _

_|5elect all events MOT selectad abowe

Fename salected event typels)as type:

Retain ald avants spponamasiin (nows figld namad: |

Jat this button (1o left)and "all BUT" buttons (abowe) for logical OR

| button 1

|_|Keep only selected events and ramowve all other events |

Cancel |

Help | Ok
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Renaming events

.
B EEGLAB v7.1.7.18b

Dataset info

Ewvent fields

Append datasets

File mTtmls Plot Datasets Help
ntinuous -- Rere...

About this dataset

: 70
Channel locations
10133
Select data 1
Select data using events 1303
Select epochs ar events 260
Copy current dataset 0.000
2440 52

i Vil
Delete dataset(s) i

[CA weights es
Datazet size (Mh) 344

Edit event values — pop_editeventvals()

e

|
varte 8§~
il -

Computational
Neuroscience

Edit event field values {currently #32 events) Dalate avant
Latency (sec) | | 224
Type | [ C buttonl )

Event Mum

Insert event | << | < | 3 [ > | =»> | Append event |

Re-order events {for review only)
Main sorting field: i
secondary sorting fiald:

Re-sort |

Cancel | Help | Ok

_IClick for decreasing order
_IClick for decreasing order
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Event durations

Neuroscience

Scroll channel activities — eegplot) CO | O r d en Otes

/ event duration

=

Figure Display Settings  Help

bpd
ohje.
bp1

RN

e01
e0z
803
e04
eds
elf
ed?
208
209
elo
el
elz
el3
eld
e1s
elg
ey
e1g
e1g
e20

ezl
ezz
e23

ez4
825
k]
8z7
ez8
=2 Scale
edn
ed1

70
edz

233

Chan, Time Yalue

+
CANCEL Event types ‘ << < 0 > 55 233 51.7242 -133 70 J REJECT ‘
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Data importing and channel analysis

Task 4
Extract data epochs
Select epochs/events
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Extract epochs

| b My A
| B TR A O P | Ny ey S I A LI‘I' N
. bod P W M "'dlr' W A pand A e A A n o A L | ah A ) ! i I \ s o T |
W e [ NN g W AT T A Wl Wb W Wl AN A LY AR AN WL b T TN -
i1 .‘|I . 1"“_.‘1‘1 ! ,-1,,', o I ¥ ] Wo¥ L Lt A | y WYy --H|“"’.' Yo N R W T . LT "L\.‘-,J"u..‘ |"I '\ lflr v ']-‘f___-"'1l|‘-|‘l" W e |
Al . \ |

lot Study Datasets Help

File Edit K

Change sampling rate

Filter the data

Re-reference

Interpolate electrodes

Reject continuous data by eye
Extract epochs

Remuowe baseline
Run ICA

Remowe components

Automatic channel rejection

Automatic epoch rejection
Reject data epochs ]
Reject data using ICA b

Locate dipoles using DIPFIT 2 »
Peak detection using EEG toolbox
FMPRIE Tools
Locate dipoles using LORETA
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Extract epochs

bt

g

Dataset info -- pop_newset() l

o |

What do you want to do with the new dataset?

Marme it: Sternberg Response Epochs

Edit description

Save it as file: Browse

Some changes have not been saved. Wha

Cwerywrite it in memory (set=yes; unzet=c

Epoch baseline removal -- pop_rmbase()

o e

Save it as file: Bazeline latency range (min_ms mamx_

-1000

Cancel Elze, bazeline points vector (ex1:56)

[owerwritten by latency range above)

Cancel | Helg

EEG = pop epoch ( EEG, {"out®, "iIn-
[-1 2], "newname”®, ...

"Sternberg Continuous -- Reref"d epochs”, ...
"epochinfo®, "yes®);

[ALLEEG EEG CURRENTSET] = pop_newset(ALLEEG, ...
EEG, 2, "setname”, "Sternberg Response Epochs*®,.
"gui®, "off");

EEG = pop_rmbase ( EEG, [-1000

)

0D:

J

Neuroscience

EEGLAB v7.17.18b

=1

—

File Edit Tools Plot

Filename: none
Zhannels per frame
Frames per epoch
Epochs

Events

Sampling rate (Hz)
Epoch start {sec)
Epoch end (sec)
Feference
Zhannel locations
|CA weights
Dataset size (Mh)

Datasets Help

71
a0
100
fivly)
280
-1.000
1.896
Linknon
Tes
Yes
452

—#2: Sternberg Response epochs

-

-
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Select epochs

EEGLAB v7.1.7.18b

File

Tools Plot

Dataset info

Event fields
Eventwalues
About this dataset
Channel locations
Select data

Select data using events

Copy current dataset
Append datasets

Delete dataset(s)

|ZA weights
Datazet size (Mb)

Select events -- pop_selectevent() =REEN X
Field Selection Set=HOT THESE
latency (me) Mo description Hiir i i 0
= duration (ms] Mo description min Max
type Mo description in' J
Datasets Help Trial Mo description
Event_Type Mo description
sponse Epochs— e [ deseriplor
Uncettairty Mo description
Duration Mo description
Uncerainty2 Mo description
71 ReqTime Mo description
RegDur Mo description
740 init_incie:: Mo description
1 DD init_tirme: Mo descrigtion
255 Izl Mo descrigtion
250 epoch Mo description
_1 DDD Evert indices
1 BE‘E Select all events NOT selected above Set this button (to left) and “all BUT" buttons (abowe) for logical OF
Unkﬂ O Rename selected event type(s) as type:
s Retain old event type rame(s) in (nevw) field named:
YE = Keep only selected events and remove all cther events
45 2 + | Remove epochs not referenced by any selected event

Invert epoch selection

Cancel Help Ok

>> EEG = pop_ selectevent(EEG, "type",{“In"}, ...
"deleteevents”, "off","deleteepochs”,"on");

>> [ALLEEG

EEG CURRENTSET] = pop_newset(ALLEEG,EEG,4, . ..

"setname”, "faces only epochs*®);




Select epochs with specific events

h A
o N (s A

L ', WA A i
ﬂl Plf"‘ 1" 1'|' " B Swarts ;
L Center for
Cvmpuullwml
MNeuroscience

LNl Tools Plot Study Datasets

Dataset info

Ewvent fields

Event values

About this dataset
Channel locations
Select data

Select data using events
Copy current dataset
Append datasets

Delete dataset(s)

Mo description
Mo description
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Cancel __ Ok |

__ Nodescripion |

_ MNodescription |

_ MNodescripon |1 (i ]

__ Modeserption ||  —e

__ Medescrpton |

__ MNodeserpfion |

_ Medescripton |

___ Modeserption ||

__ Modeserpton |

___ Modeseripion |

__ Medescripton |

___ Modeserption ||

_ Modescrpton |

__ Medescrpton |

__ Modeserption ||

]
::c|‘i

I
]
f
i
_ Cancel |




Repeat for ‘out-of-set’ responses

b
H.-l I" N |_r.' i I'II

|
e pd N
LT
WA

Swarts
Center for
CUmpu[uIlulml
MNeuroscience

o

Mo description
Ma description
Mo description
Ma description

Mo description

Mo description

Mo description

Ma description

Mo description

Mo description

Mo description

Ma description

i

Mo description

i
g
L

R

Sternberg: Probe Out of Set Edit description I

CWlzersijulis\DocumertsWWorkshopsWbust

Cancel
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Separate datasets with different conditions
-

—

Neuroscience

._‘\ e

(B exGLae v7.27.180 licnlmeSem) | B eecLaB v7.27.180 o S
File Edit Tools Plot Datasets Help - File Edit Tools Plot Datasets HE||‘.'I L

__#1: Sternberg: Probe Outof Set —#2: iternberg: Probe- In Set

Filename: . pstAustralia\Datalstern set

Channels per frame
Frames per epoch
Epochs

Events

Sampling rate (Hz)
Epoch start (sec)
Epoch end (sec)
Feference
Channel locations
ICA weights
Datazet size (Mhb)

71
1500
&4

154
280
-1.000
4 496
Lnknowen
Tes
b=t
A0.7

Filename: none
Zhannels per frame
Frames per epoch
Epochs

Events

Sampling rate (Hz)
Epoch start (sec)
Epoch end (sec)
Feference
Channel locations
ICA weights
Dataszet size (Mh)

71
1500
56

192
280
-1.000
4 996
Lnknown
Tes
TEes
51.1
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Merge (append) datasets

| o M " M | §

- 1 Mt f A I.l
] P EED M Ll A e e o [ P ALY A
Pl hon Ay ‘dl'- Wl Aoy A W) I."l W it L0 ol AL MW [ N ‘._\‘I;,Nr“,. rﬂl.u ol .‘."'h*..l |'r ‘]a‘.r'Lr o I"I"" YN
. F- y . o \ J " A\ \ - ol iy . - i,
o w.‘|;1 W P ¥ ! o W |1y vl N R Y ) W

W

H?“

NK‘HICIS(IE'I"U."

 File J208| Tools Plot Study Datasets Help
Dataset info
Event fields
Ewventwvalues
About this dataset

Channel locations

Select data
Select data using events

Select epochs or events “

Copy current dataset

Append datas

Delete dataset(s)
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Merged datasets

| - fu |
an 1 gy L Ay I A
[ T I Fﬁ A ﬁu'“i\‘l\ l\'l"dlr.' LTS P -w'.] VA N A Ve, LS W [1{ LA I | N o
] \ NLEANL VR LT b A ALRTELR Y e S \ oyt AW (] ey AT | . [
1|_ ,!I |-l|‘-|'| L.‘!ﬁ Inu-' 1_.', p’*‘ y A ' : v II.'I JLW‘ I\-'-r"l ' ‘l"'ql‘ql \WIL'\‘\'FM v "HI%' Y ”"ﬂ k-|| I'u"l“.' ""r‘n'u"r“ ll"..'-..a"u’ nﬁ’l l.JI‘ ""
W

| I'Jl b )
My g

B EEGLAB V727 = o o )

File Edit Tools Plot Study Datasets Help

EEGLAB Workshop X, June 14-17, 2010, Jyvaskyla, Finland: Julie Onton — Data import



Data importing and channel analysis

Task 4
Channel analysis
Exercise...
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Analysis of ERPs

. — —
. Bl ERP data and scalp maps - pop_timtopﬂ{}L E@ﬂ
Y

. Plotting titme range (ms): =200 500
%;? Zralp map latencies (me, Makl = max-Ris) Mah
Plat title: ERP data and scalp maps of !

r — Scalp map options (2ee == help topoplot]):
B £EGLAB v7.17.18b A T

File Edit Toals IHBI Datasets Help o T Cancel Help Ok

#3: St Channel locations } h 1 '!é e —
- el Channel data (scroll) s FEHE 220
. Channel spectra and maps 76
EILEF‘IamlE. Channel properties
Arnels
Frames pe Channel ERP image i
Epochs Channel ERPs b With scalp maps
Events ERP map series b Inscalpfrect array
Sampling 1 Sum/Compare ERPs
Epoch sta Component activations (scroll) +:
E[ﬂ?th =nd Component spectra and maps
ETEMENCE
e e Component maps L
ICA weight Component properties S"‘ 4_
Dataset = Component ERP image 5 2.
Component ERPs » ©
Sum/Compare comp, ERPs 'E 0
L
Data statistics L -lc—:"
Time-frequency transforms P o -2- :
Cluster dataset ICs
-4,; I t I I I 3

>> pop_ timtopo(EEG,[-200 500],[NaN], "ERP data and scalp maps®);



Analysis of ERPs

: CQ.mpumbnal
‘,, MNeuroscience
=

-
B E£GLAB v7.17.18b ‘ [EEREE B Figure 2 plotopo o
- . - File
File Edit Tools JGIE Study Datasets Help L]
- DEEE 220
Channel locations b
—#2. Ste chs
Channel data (scrall} Sternberg memorize epochs
_ Channel spectra and maps REYE

Filename: Channel properties

Channels - e

Frames pe anne image

Epochs With scalp maps

e :
Events ERP map series | Inscalp/rect. array “ﬁ“UﬂW H,Vﬂw WFE 9
. F. o AFZ
Sampling Sum/Compare ERPs A Nslvdy,w ] b I F%Fﬂ%ﬂ
J Fa EA?VA
Epoch sta Component activations (scrall) F hm@ 7| F2 TGS )
] LA e T - FTio
FCs F&'Vﬂ“"‘v‘ e iUkl
| el Fel | e Fel |

Epoch enc
Reference

Channel |
ICA weighf Component properties

Datazet =i Compaonent ERP image

Component spectra and maps

Companent maps ]

Component ERPs L

Sum/Compare comp. ERPs

Data statistics [
i — b
B Topographic ERP plat - pop_plottopal) y E@g il

%ﬁpoi | ik P
i PO
Channels to plot 171 podl o o o PO&

Plat title Sternberg memarize epochs
Flot zingle trialz [] (zet=yes) v
Plot in rect. array [] {zet=yes) %
ther plot aptions (=ee help) ylir', 1 -quu 9
Time (s)
Cancel I Help I Ok I
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Channel ERP In rectangular array
-

o Center

3 Computational
J&_‘? Meuroscience
u EEGLAB v7.1.7.18b ‘ | e s
File Edit Tools Datasets Hel ~ Ced& 210
P
Channel locations b
#2: Stel Channel data (scroll) chs Sternberg memorize epochs
Fi Channel spectra and maps -1 22 -3 T 4 -5 _6 -1 8
IEname: .
Channel properties sl P, Al b PN JMP\P’M\ b ad_ft et ot
Channels " P v v it iy Vo Y e e
anne Image H 4 4 L 4 L L 4
Frarmes pe —— J N 19 10 -1 12 -1 L1 +15 16
EpDChS dannel 3 I scalp maps - I\V g A - h . -‘V A A Aa o f\w ﬂv‘
Events ERP map series r In scalp/frect. array s YV (R W L i Y i [V
Sampling | Sum/Compare ERPs 7 18 _[19 ng 7 » 5 o
Epoch sta Companent activations (scroll) Vf\ = \\/{h Vﬂ v vf\, W"’qﬂw%w W*—Uﬂqvwﬂ W—U%'vv ,.,b-.-vﬂva-.?
Epoch enc J J
Component spectra and maps & & + L L L
Reference - . ) ) . ﬁ T25 T29 30 3 .
omponegnt maps
Channel Ic ¢ = A 4 i by ol 1 & .
[ WEigh1 Compaonent properties D/ D/ Df
Dataset =i Component ERP image -3 4 fS —36 f? -3 -3 40
Component ERPs » " U’\ 7 A P,f‘" 2 u VA P/{\V vﬂ\,v + Vﬂ\f VAV
L | Sum/Compare comp. ERPs & & & L L L
—_— —_— 4 42 43 - 45 46 A7 48
Data statistics k vU(\V o }J }‘ N o 3
i ™y
Topographic ERP plot - pop_plottopol() =2 1 1 1 1 AL AL
n ek & a7 e 49 50 J51 52 53 54 =) 56
AN 1 # a p AW AW
Channels to plot 1:74 VA g “’f\j ST JV il T
Plot title Sternberg memorize epachs ar T 59 :ﬁEU J51 i) 8 ::ﬁd
Plot =incle trizls [ (set=yes) SO A W o W n\fwm AVW A AU y J\Vr"m - vrww
Plot in rect. array [set=yes} 1l 587
o - 65 66 67 68 9 0 -
SE e eptEms (552 =) 'y, 1 sl a o wl oA sl adlese allee, sl
v kil \Jf T \JJ v VTV ViV 3
- 200 4
Time: (ms)
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Analysis of ERPs

B Plot ERP scalp maps in 2-D -- pop_topoplot() =HRCIN X

Plotting ERP scalp maps at these latencies |j;25;2?5|
[range: -200 to 496 ms, MaM -= empty):

(= |-5"3‘—-|1'l

.
.;\",{,_:f._—
B EEGLAB +7.1.7.18b
File Edit Toaols Datasets Help
#2 St Channel locations
- €l Channel data (scroll)

: Channel spectra and maps
Filename: Channel properties
Channels h .

Frames pe anne image
Epochs Channel ERPs

Sampling 1 Sum/Compare ERPs
E[CIEII:h sta Component activations (scroll)

Epoch enc Component spectra and maps
Reference - :

omponent maps
Channel Ic 3 :

|CA weight Component properties
Dataset =i Component ERP image

Component ERPs

Sum/Compare comp. ERPs

Data statistics

Time-frequency transfarms

Cluster datasetICs

¥

¥

¥
¥

ths —

Events ERP map series ]

In3-D

B Figure 2 o
File ~

DeEE 220

5.3
26

-26
5.3

Sternbery memorize epochs

pop_topoplot(EEG,1,[0:25:275], “Memorize™,[3 4],0, electrodes”, "off");
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Compare ERPs across conditions

| "'m M EREN L i
| 1y A LI | A e ! i
A L / T AL ey | v A
.Fr'. A g ..," 1y |_r, ' LT W M S |, Al I-'"'l. (LR LY, { T | \
LN ! LR

| o [ AL LW o A )
. \ J A T J [ ™

W ey T ", W I"‘,|'f’.1"'||" 1 WA by Waa /L A L M | L ] POrLL Ty oy

! W N I L W [ S b, \ \ W LT LAY AT N BT Al (AT )
WAy T ’ Vo U A L e B A B B U S TV AL T L f

¥
W

NK‘HICIS(IE'I"U."

EGLAB v7.1.7.18
File Edit Tools Plot Study REEREHI

Dataset L:Sternberg Continuous Data

v Dataset 2:5ternberg Memaorize epochs

Dataset 3:5ternberg Ignore epochs

Select multiple datasets

How do 'Memorize'
and 'Ignore' ERPs
differ?
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Compare ERPs across conditions

&
o e—

o

Neuroscience

EEGLAB v7.1.7.18b

[ -

49 &t Channel location
. el Channel data (sci
_ Channel spectra :
Filename: Channel properti
Channels Chammel ERP i
Frames pe AnnEl Er e
Epochs Channel ERPs
Events ERP map series
=rlglalabl|  Sum/Compare E
Epoch sta Component acti
Ep?ch Eng Component spec
ETEIENCE
c t
Zhannel Ic ot
A wieigh Component prog
Datazet i Component ERP
Component ERP:
Sum/Compare cc

Data statistics

File Edit Tnnlsm Datasets Help ﬂ|

Compare ERPs

r ERP grand average/RMS - pop_comperp() l — | (] |_i3-]

from two conditions

av. std.  all ERPs
Datazets to average (ex: 1 34 23 7]
Datasets to average and subtract (ex: 56 7
Plot difference

Channels subset ([]=all):

Highlight =significant regions (.01 -= p=.01]

ze RMS instead of average (check):

Lowy pass (HZ) (for display only) 20

Plottopo options ('key', "wal'): Help "yalir', 1

Cancel Help Ok

= —

b

Time-frequency transforms L

Cluster dataset ICs

>>pop_comperp(ALLEEG,1,[2 3],[1, "addavg", "off","addstd", "off",

*addall®,"on"
"tplotopt®,{"

, diffavg","off","diffstd", "off", "lowpass”, 20,
ydir®,1});
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Compare ERPs across conditions

ot

O Cantedior. 2
\‘h CQmpnlll'bnal
'x:‘-? Neuroscience
u Figure 3 l o -
File Ny
bed& L0

Click on an axis

to see larger image
i

File

DEedE 220
6 T8
o St [—a2 Sternberg Memorize epochs (n=600)
P41y CcP TF%WH ——#3 Stemnberg Ignore epochs (n=300)

o s = ' i
(=]
: E
Potential (V)
=]
-

Ve

TP10

. -200 -100 0 100 200 300 400
LA Time (ms)
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AnaIyS|s of ERP differences

|| . ™ f". I

i . I F A 0 Y LY a‘ f ol IJ -‘ | I

h “Il-l.‘-|'|.| Ml 1','1‘ Y o ‘\.\[ JI o F_,Jt \ J Moy '[ I_,l M W L ", l'.|||' ,] W ‘u ! 'f"-"."' ! [ "" |.‘| r‘l Uﬁﬂ%
L | ﬂl.l W J\

Plot difference
between two conditions

>> pop_comperp(ALLEEG,1, 2, 3,"addavg”, "off",
"addstd", "off", "diffavg","on","diffstd", "off",
"lowpass®,20, "tplotopt”,{"ydir",1});
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Analysis of ERP differences

ERP
difference

between

2 conditions
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Remove channel

&
e

Chiafkancnn

" D o Neuroscience
Figure Display Settings Help k]

Scale
] 3
| : | e A e oA e e AL (R
450 451 452 453 454
Chan. Time alue
e BT | =< |<| 448 A => o1 451.0963 36619 33 j REJECT
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Remove channel(s)

i

| il ,I M N JW' d f A A e""'.a |1 | i) My

W, . 0 T T I Iy SN A A UL T R WA | N o T A
a b \ [ LWL TN LU PPTO At TL PALUAT LN WA W ,u‘ll'.f T L T s PO RV T | . LT
"..;H”L'" '.\.-‘1;1 Iﬂ,,-' i " ‘ v V "I"m* WY M N TN U W Ty Ijllf. A I!li )

W

Dataset info

Ewvent fields

Event values

Aboutthis dataset

Channel locations
ect data

Select data using events

Select epochs or events

Copy current dataset
Append datasets
Delete dataset(s)

N

Scrall dataset
o |
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Removing channel(s)

| - fu |
an 1 gy L Ay I A
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Scraoll dataset
o

_ cacer | Wb | o |
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Channel removed
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Interpolate bad channel

Vo i M | A _ " Uk .
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euroscience

Choose a channel from other dataset

File Edit BIELH

Change sampling rate
Filter the data »

Plot Study Datasets

Select from non-data channels
Select from other dataset
Usze list of other dataset

Auto-select deleted

Re-reference

Interpalate electrodes Spherical  w
Reject continuous data by eye -
o |

channel from other dataset

Extract epochs

Rermowe baseline
Run ICA

Remowve components

Automatic channel rejection

Automatic epoch rejection
Reject data epochs ]
Reject data using IC4 ]
Locate dipoles using DIPFIT 2.x »
Pealk detection using EEG toolbox
FMPRIE Tools
Locate dipoles using LORETA

Select from non-data channels

Select from ather dataset
Use list of other dataset

Spherical -
o |
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Interpolated channel

z ntepfar -
‘\r :_:f___ euroscience
Figure Display Settings Help L

Channel order changes, but scalp location is correct

Scale

MWWT
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Exercise

ALL
-Load stern.set
-Do not save your changes under the same filename!

Novice
-Re-reference the data to Cz.
-Scroll data and explore plotting options under 'Settings'.

Intermediate

-Load channel locations from .loc file in ‘Data’ folder, explore
options to transform axes.

-Review events in Edit->Event values, rename an event in Select
epochs/events.

-Remove a channel and then replace it by interpolation.

Advanced

-Epoch the data on Memorize and Ignore letters separately, then
use pop_comperp to compare ERPs between conditions.

-Explore other menu options.
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